
QUIZ ~  1 

Microsoft PowerPoint is used to create what? 

A. Accounting 

B. Documents 

C. Presentation 

D. Database 

QUIZ ANSWER ~ : C 

QUIZ ~  2 

What is the file extension for MS PowerPoint? 

A. .docx 

B. .xlsx 

C. .pptx 

D. .txt 

QUIZ ANSWER ~ : C 

QUIZ ~  3 

Which of the following listed below serves as the background for PowerPoint Presentation? 

A. Worksheet 

B. Document 

C. File 

D. Slide 

QUIZ ANSWER ~ : D 

QUIZ ~  4 

Which view is used to present slides in full screen mode? 

A. Slide show 

B. Reading view 

C. Normal 

D. Slide sorter 

QUIZ ANSWER ~ : A 

QUIZ ~  5 

In what view can all slides be displayed at a go? 

A. Outline 

B. Slide sorter 

C. Slide show 

D. Normal 

QUIZ ANSWER ~ : B 

QUIZ ~  6 

On which group or section on the Home tap ribbon can 'New Slide' be located? 



A. Clipboard 

B. Paragraph 

C. Slides 

D. Drawing 

QUIZ ANSWER ~ : C 

QUIZ ~  7 

On which Menu tap can 'On Mouse Click' checkbox be located? 

A. Insert 

B. Home 

C. Transitions 

D. Animations 

QUIZ ANSWER ~ : C 

QUIZ ~  8 

Which one of the list below is not a Presentation view in PowerPoint? 

A. Note Page 

B. Reading 

C. Outline 

D. Review 

QUIZ ANSWER ~ : D 

QUIZ ~  9 

In print options which of these print settings can print out only the text on Slides excluding slide backgrounds? 

A. Full Page Slides 

B. Note Pages 

C. Outline 

D. Collated 

QUIZ ANSWER ~ : C 

QUIZ ~  10 

Which one of these listed below is used as settings for changing slide background? 

A. Themes 

B. Slide show 

C. Preview 

D. Export 

QUIZ ANSWER ~ : A 

QUIZ ~  11 

Which of these listed below is a slide layout? 

A. View 

B. Blank 



C. Preview 

D. None 

QUIZ ANSWER ~ : B 

QUIZ ~  12 

What are the special effect that affect the slides display when moving from a slide to another? 

A. Transition 

B. Animation 

C. Print preview 

D. Zoom slider 

QUIZ ANSWER ~ : A 

QUIZ ~  13 

What are the special effects that can be applied on the text and objects on a slide to display in styles when 

playing or slide showing? 

A. View 

B. Note page view 

C. Animation 

D. Transition 

QUIZ ANSWER ~ : C 

QUIZ ~  14 

Which of the following is not a type of slide layout in PowerPoint? 

A. Draft 

B. Title and Content 

C. Comparison 

D. Title Only 

QUIZ ANSWER ~ : A 

QUIZ ~  15 

Which of the following keys is used to end a slide show? 

A. Shift    

B. Ctrl + end    

C. Esc    

D. Tab 

QUIZ ANSWER ~ : C 

QUIZ ~  16 

Under which of the following tabs would you find themes? 

A. Home    

B. Insert    

C. Design     



D. Transitions   

QUIZ ANSWER ~ : C 

QUIZ ~  17 

A PowerPoint presentation can be converted to PDF? 

A. True 

B. False 

QUIZ ANSWER ~ : A 

QUIZ ~  18 

Which file format can be added to a PowerPoint show? 

A. .jpg 

B. .gif 

C. .wav 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  19 

Special effects used to introduce slides in a presentation are called 

A. effects 

B. custom animations 

C. transitions 

D. present animations 

QUIZ ANSWER ~ : C 

QUIZ ~  20 

What is the term used when you press and hold the left mouse key and move the mouse around the slide? 

A. Highlighting 

B. Dragging 

C. Selecting 

D. Moving 

QUIZ ANSWER ~ : B 

QUIZ ~  21 

Which of the following is the default page setup orientation of slide in PowerPoint 

A. Vertical 

B. Landscape 

C. Portrait 

D. None of above 

QUIZ ANSWER ~ : B 



QUIZ ~  22 

Objects on the slide that hold text are called 

A. Placeholders 

B. Object holders 

C. Auto layoutsD. Text holders 

QUIZ ANSWER ~ : A 

QUIZ ~  23 

Which of the following can you use to add times to the slides in a presentation? 

A. Slide show menu 

B. Rehearse timings button 

C. Slide transition button 

D. All of the above 

QUIZ ANSWER ~ : B 

QUIZ ~  24 

When using PowerPoint, to play a PowerPoint show for previewing the show, select 

A. slide sorter 

B. slide 

C. slide show 

D. View outline 

QUIZ ANSWER ~ : C 

QUIZ ~  25 

In Microsoft PowerPoint in order to see all the slides on one screen use 

A. slide sorter 

B. slide 

C. master view 

D. slide show 

QUIZ ANSWER ~ : A 

QUIZ ~  26 

Which of the following should be used when you want to add a slide to an existing presentation? 

A. File, add a new slide 

B. Insert, new slide 

C. File, open 

D. File, new 

QUIZ ANSWER ~ : B 

QUIZ ~  27 

To save a presentation you 



A. click save on the windows start button 

B. press Ctrl + F5 

C. select File, Save from the menu 

D. click the saver button on the formatting toolbar 

QUIZ ANSWER ~ : C 

QUIZ ~  28 

To change font size of a selected slide title, you: 

A. Click the toolbar's dropdown arrow and choose the font you prefer 

B. Click Format, Title and choose a font from the font tab 

C. Click the toolbar's Increase Font Size button 

D. Click Title, New Font, OK 

QUIZ ANSWER ~ : C 

QUIZ ~  29 

To insert a new slide in the current presentation, we can choose 

A. Ctrl + M 

B. Ctrl + N 

C. Ctrl + O 

D. Ctrl + F 

QUIZ ANSWER ~ : A 

QUIZ ~  30 

Microsoft PowerPoint is a 

A. Database program 

B. Spreadsheet program 

C. Presentation program 

D. Word processing program 

QUIZ ANSWER ~ : C 

QUIZ ~  31 

Special effects used to introduce the objects on the slides in a presentation are called 

A. Effects 

B. Transition 

C. Animation 

D. Pre-set effects 

QUIZ ANSWER ~ : C 

QUIZ ~  32 

Which key on the keyboard can be used to view slide show 

A. F1 

B. F2 

C. F5 



D. F10 

QUIZ ANSWER ~ : C QUIZ ~  

33 Which of the following fill 

effects can you use for the 

slide background? 

A. Gradient 

B. Texture 

C. Picture 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  34 

Which of the following statements is not true? 

A. Holding down the Shift key while you draw an object creates perfect squares, circles and straight lines 

B. The text in a text box can't be formatted 

C. The drawing toolbar contains tools for drawing shapes, lines, arrows, and more 

D. Ctrl+S save the document 

QUIZ ANSWER ~ : B 

QUIZ ~  35 

A chart can be put as a part of the presentation using 

A. Insert -> Chart 

B. Insert -> Pictures -> Chart 

C. Edit -> Chart 

D. View -> Chart 

QUIZ ANSWER ~ : A 

QUIZ ~  36 

The arrangement of elements such as Title and Subtitle text, pictures, tables etc. is called 

A. Layout 

B. Presentation 

C. Design 

D. Scheme 

QUIZ ANSWER ~ : A 

QUIZ ~  37 

The special effect applied to change the way in which we move from one slide to another is? 

A. Animations    

B. Transitions 



C. Change Over     

D. Swap 

QUIZ ANSWER ~ : B 

QUIZ ~  38 

Which of the following cannot be inserted into a slide? 

A. Audio File    

B. Video File 

C. Chart 

D. Cell 

QUIZ ANSWER ~ : D 

QUIZ ~  39 

The file extension for PowerPoint 2010 is? 

A. .ppt 

B. .pptx 

C. .ppts 

D. .ppta 

QUIZ ANSWER ~ : B 

QUIZ ~  40 

Which of the following is not a type of view in MS PowerPoint? 

A. Page Layout 

B. Slide Sorter 

C. Slide Master 

D. Handout Master 

QUIZ ANSWER ~ : A 

QUIZ ~  41 

Which of the following is not a type of slide in PowerPoint? 

A. Title and Content 

B. Comparison 

C. One ContentD. Two Content 

QUIZ ANSWER ~ : C 

QUIZ ~  42 

Which of the following views could best   be used to rearrange slides? 

A. Slide sorter 

B. Print Layout 

C. Slide Master 

D. Handout Master 



QUIZ ANSWER ~ : A 

QUIZ ~  43 

A PowerPoint presentation cannot be converted to PDF? 

A. True 

B. False 

QUIZ ANSWER ~ : B QUIZ ~  

44 

A ____________ provides predesigned colors and designs that are applied to each slide to give presentation 

a professional look.  

A. Theme  

B. Font  

C. WordArt  

D. All of the Above  

QUIZ ANSWER ~ : A 

QUIZ ~  45 

The shortcut key for starting a slide show is? 

A. F1 

B. F4 

C. F5 

D. F6 

QUIZ ANSWER ~ : C 

QUIZ ~  46 

Which of the following cannot be inserted into a slide? 

A. Audio File    

B. Video File 

C. Chart 

D. Cell 

QUIZ ANSWER ~ : D 

QUIZ ~  47 

MS PowerPoint is mostly used for? 

A. Data manipulation 

B. Word processing 

C. Data storage 

D. Presentation 

QUIZ ANSWER ~ : D 



QUIZ ~  48 

What is the shortcut key for starting a presentation from a current slide? 

A. Shift F6    

B. Ctrl + F6 

C. Shift + F5   

D. Ctrl  + F5 

QUIZ ANSWER ~ : C 

QUIZ ~  49 

The rectangular frame into which text or graphics are inserted is called? 

A. Object Holder   

B. Placeholder    

C. Text Box    

D. Object Box 

QUIZ ANSWER ~ : C 

QUIZ ~  50 

Which of the following views could best   be used to rearrange slides? 

A. Slide sorter 

B. Print Layout 

C. Slide Master 

D. Handout Master 

QUIZ ANSWER ~ : A 

QUIZ ~  51 

The special effect applied to change the way in which we move from one slide to another is? 

A. Animations    

B. Transitions 

C. Change Over     

D. Swap 

QUIZ ANSWER ~ : B 

QUIZ ~  52 

The effect applied to change the ways objects on a slide move in and out is called? 

A. Animations     

B. Transitions    

C. Patterns      

D. Paint 

QUIZ ANSWER ~ : A 

QUIZ ~  53 

What are the two transition options available in MS PowerPoint? 



A. On arrow pressed and On Mouse Click   

B. On Mouse Click and Automatically    

C. On Arrow Pressed and Automatically 

D. Up Arrow and Down Arrow   

QUIZ ANSWER ~ : B 

QUIZ ~  54 

What would you do to reduce the length of an inserted video file? 

A. Trim the Video    

B. Truncate the Video     

C. Cut a part    

D. Prune the video 

QUIZ ANSWER ~ : A 

QUIZ ~  55 

What would you do if you want to place a selected picture in front of another which is already in front? 

A. Bring In front    

B. Bring Backward    

C. Bring to Front    

D. Send to Front 

QUIZ ANSWER ~ : C 

QUIZ ~  56 

The file extension for PowerPoint is? 

A. ppt      

B. pptx    

C. ppts    

D. ppta 

QUIZ ANSWER ~ : B 

QUIZ ~  57 

Under which tab can we find the Background Style option? 

A. View    

B. Animation      

C. Transition 

D. Design 

QUIZ ANSWER ~ : D 

QUIZ ~  58 

Which of the view options in the slides pane allows you to focus on the text being entered rather the design of 

the slides? 

A. Slides View    

B. Outline View     



C. Design view     

D. Print layout 

QUIZ ANSWER ~ : B 

QUIZ ~  59 

After designing a presentation, which of the following is the best way of preparing the final output for use? 

A. Save a PDF copy   

B. Save the presentation in Documents Folder 

C. Package the Presentation for CD   

D. copy on a Floppy disk 

QUIZ ANSWER ~ : B 

QUIZ ~  60 

Which of the following keys is used to end a slide show? 

A. Shift    

B. Ctrl + end    

C. Esc    

D. Tab 

QUIZ ANSWER ~ : C 

QUIZ ~  61 

Microsoft PowerPoint is used to create 

A. Flyers 

B. Word documents 

C. Spreadsheets 

D. Presentations 

QUIZ ANSWER ~ : D 

QUIZ ~  62 

To open PowerPoint for the first time 

A. Double Click the PowerPoint icon on the desktop 

B. Click Start ? All Programs ? Microsoft Office ? Microsoft Office PowerPoint 2013 

C. Click Start ? Microsoft Office PowerPoint 2013 

D. Click Start ? My Documents? presentation 1 

QUIZ ANSWER ~ : B 

QUIZ ~  63 

To add a default slide 

A. Click Home? Click top of the New Slide command 

B. Click Slides ? Click bottom add slide button? Click Title and 2 column text 

C. Click Insert ? Click bottom add slide button ? Click Title and Content 

D. Click Slides ? Click bottom add slide button? Click Blank 



QUIZ ANSWER ~ : A 

QUIZ ~  64 

To Copy a slide 

A. Select Slide ? click copy from the Home ribbon 

B. Select slide ? right click ? click Copy 

C. Highlight all contents on the slide ? click copy from the Home ribbon 

D. Both A and B 

QUIZ ANSWER ~ : D 

QUIZ ~  65 

To cut text from a slide 

A. Highlight text? click Cut in Home ribbon 

B. Highlight text ? right click ? click Cut 

C. Select text box ? click cut 

D. All of the Above 

QUIZ ANSWER ~ : D 

QUIZ ~  66 

The suggested feature to replace the word text with content in a presentation is: 

A. To delete all 'text' words and replace them all manually 

B. Use Find and Replace 

C. Use Go To 

D. Use Find 

QUIZ ANSWER ~ : B 

QUIZ ~  67 

The Save As command is used to 

A. Make a duplicate copy of a presentation 

B. Save the same file to a different location 

C. Save for the first time 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  68 

To close a presentation without closing the program  

A. Click File ? Close 

B. Right Click on the Minimized window ? Click close 

C. Click the PowerPoint icon at the top left side of the window ? click close 

D. Both A and B 

QUIZ ANSWER ~ :  



QUIZ ~  69 

To slant text in order to add emphasis, use the 

A. Bold command 

B. Shadow command 

C. Italicize command 

D. Shrink font text 

QUIZ ANSWER ~ : C 

QUIZ ~  70 

To place a paragraph in the middle of a text box click 

A. Justify  

B. Justify center 

C. Align text ? middle center 

D. Both B & C 

QUIZ ANSWER ~ : D 

QUIZ ~  71 

To Apply Vertical text direction 

A. Click Text align 

B. Click Text direction? horizontal 

C. Click text direction ? rotate 90° 

D. Both A & B 

QUIZ ANSWER ~ : C 

QUIZ ~  72 

Animations are applied to  

A. Images only 

B. Text box only 

C. The whole show; each slide will have the same animation 

D. Any item in a slide 

QUIZ ANSWER ~ : D 

QUIZ ~  73 

To insert a picture 

A. Right-click the empty slide ? Add Picture 

B. Home ribbon ? Insert Picture 

C. Slide Show ribbon ? Add Picture 

D. Insert Ribbon ? Picture 

QUIZ ANSWER ~ : D 

QUIZ ~  74 

If you wanted to add music to the introductory slide, you would… 



A. Insert a sound file 

B. Insert a movie file 

C. Record a voice narration 

D. Any of the above 

QUIZ ANSWER ~ : A 

QUIZ ~  75 

To change the overall look of a slide 

A. Apply a design theme 

B. Apply a Background Styles 

C. Apply a color scheme 

D. All of the above 

QUIZ ANSWER ~ : D QUIZ ~  

76 

To have a title fly in and out 

A. A slide transition must be applied 

B. A custom animation effect must be applied 

C. A timer must be applied 

D. Both A & C 

QUIZ ANSWER ~ : B 

QUIZ ~  77 

A custom animation is 

A. An entrance effect for a title or word 

B. An exit effect for a picture 

C. An emphasis effect for a bulleted sentence 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  78 

To look up the definition of a word using PowerPoint 

A. Use the Thesaurus feature 

B. Use the All Reference Books feature in the Research pane 

C. Use the dictionary feature 

D. Both B & C 

QUIZ ANSWER ~ : D 

QUIZ ~  79 

A Placeholder is a built in box that can contain 

A. Text 



B. Pictures 

C. Charts 

D. All of the Above 

QUIZ ANSWER ~ : D 

QUIZ ~  80 

To resize a Placeholder  

A. Click placeholder? hold and drag out corners 

B. Click placeholder ? select appropriate sizing handle ? hold and drag to increase or decrease 

C. Click placeholder? hold and move to another location 

D. Both A & B 

QUIZ ANSWER ~ : B 

QUIZ ~  81 

To Delete a placeholder containing text 

A. Click inside text bos and delete 

B. Click text box lining ? delete 

C. Click text box lining ? delete ? click text box lining ? delete 

D. Any of the above 

QUIZ ANSWER ~ : C 

QUIZ ~  82 

To add a background color only, to a slide 

A. Click on a design theme ? click color scheme 

B. Click Background Styles ? apply color 

C. Click background ? right click? click Background Styles ? apply color 

D. Both B & C 

QUIZ ANSWER ~ : D 

QUIZ ~  83 

To apply a gradient fill to a background 

A. Click Background Styles? Background ? Solid ? apply color ? set transparency 

B. Click Background Styles? Background ?Gradient ? Color ? Stop Position 

C. Click Background Styles? Background ?Gradient ? Color ? Set Transparency to 100% 

D. Click Background Styles? Background ?Texture or Picture  

QUIZ ANSWER ~ : B 

QUIZ ~  84 

To Apply Texture or a Picture to a Background 

A. Copy picture and paste onto the slide. 

B. Click Background Styles? Background? Texture or Picture ? Select File. 

C. Click Insert Picture ? locate file? Insert. 



D. Both A & C 

QUIZ ANSWER ~ : B 

QUIZ ~  85 

To Insert a Header into a slide presentation 

A. Click Header And Footer ? Check Date, Time and Footer 

B. Click Header And Footer ? Click Notes ? Check Header 

C. Click Date And Time  

D. None of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  86 

To Insert a Date as Text 

A. Click Header and Footer? check Date 

B. Click Header and Footer ? check Date and Time 

C. Click header and Footer ? check Footer ? Enter Date 

D. Click Date and Time ? Select Format 

QUIZ ANSWER ~ : D 

QUIZ ~  87 

Using a custom animation effect, how do you make text appear on a slide by letter 

A. Apply the animation scheme fade in one by one. 

B. Apply an entrance effect, and then set it to letter by letter in the effect option dialog box 

C. Apply the fly in entrance to the text, and then set its speed to very slow. 

D. All of above 

QUIZ ANSWER ~ : B 

QUIZ ~  88 

To exit the PowerPoint application, you should 

A. Click the application minimize button 

B. Click the document close button 

C. Double click the application control menu icon 

D. Double click the document control menu icon 

QUIZ ANSWER ~ : B 

QUIZ ~  89 

You can create a new presentation by completing all of the following except: 

A. Clicking the new button on the standard toolbar 

B. Clicking file, new 

C. Clicking file openD. Pressing Ctrl + N 

QUIZ ANSWER ~ : C 



QUIZ ~  90 

You have customized a design template in one presentation and you want to use it in another presentation. 

What the best way to do this? 

A. Use the browse feature in the slide design task pane to find the file that has your design template and 

applyit to the current file. 

B. Copy and paste the slide with the design template you want to include the new presentation; inserted 

slidewill inherit the design 

C. Save the presentation that has the design template with a new name, and then use a new file to 

yourpresentation 

D. All of the above. 

QUIZ ANSWER ~ : A 

QUIZ ~  91 

You can tell when an object is active because 

A. The object is highlighted 

B. Eight small sizing handles appear surrounding the text 

C. A box frame appears surrounding the text 

D. b and c 

QUIZ ANSWER ~ : A 

QUIZ ~  92 

What's the best way to design the layout for your slides? 

A. Create layouts for slides, handouts and notes using the Master Layout dialog box in slide master view 

B. For each new slide, select a layout from the Slide Layout task pane 

C. Apply templates from the Slide Design task pane 

D. None of above 

QUIZ ANSWER ~ : B 

QUIZ ~  93 

The slide that is used to introduce a topic and set the tone for the presentation is called the 

A. Table slide 

B. Graph slide 

C. Bullet slide 

D. Title slide 

QUIZ ANSWER ~ : D 

QUIZ ~  94 

Which of the following should be used when you want to add a slide to an existing presentation? 

A. File, add a new slide 

B. Insert, new slide 

C. File, open 

D. File, new 

QUIZ ANSWER ~ : B 



QUIZ ~  95 

Which of the following is the default page setup orientation for notes pages, outlines and handouts? 

A. Vertical 

B. Landscape 

C. Portrait 

D. None of above 

QUIZ ANSWER ~ : C 

QUIZ ~  96 

Which of the following is the default page setup orientation for slides in PowerPoint? 

A. Vertical 

B. Landscape 

C. Portrait 

D. None of above 

QUIZ ANSWER ~ : B 

QUIZ ~  97 

How can you get your photo album slide show to play continuously? 

A. Use random slide transition B. 

Launch an online broadcast 

C. Loop continuously 

D. All of above 

QUIZ ANSWER ~ : C 

QUIZ ~  98 

What are symbols used to identify items in a list? 

A. Icons 

B. Markers 

C. Bullets 

D. Graphics 

QUIZ ANSWER ~ : C 

QUIZ ~  99 

Objects on the slide that hold text are called 

A. Placeholders 

B. Object holders 

C. Auto layout 

D. Text holders 

QUIZ ANSWER ~ : A 

QUIZ ~  100 

Which command brings you to the first slide in your presentation? 



A. Next slide button 

B. Page up 

C. Ctrl + home 

D. Ctrl + end 

QUIZ ANSWER ~ : C 

QUIZ ~  101 

Which of the following should you do to bring a bullet back to a previous level? 

A. Press the shift + tab keys 

B. Press the shift key 

C. Press the enter key 

D. Press the tab key 

QUIZ ANSWER ~ : A 

QUIZ ~  102 

Good design determines 

A. Credibility 

B. Readability 

C. First impression 

D. All of above 

QUIZ ANSWER ~ : D 

QUIZ ~  103 

To make a selection of slides on our presentation, use a different design template from the other slides, what 

do you do? 

A. Select the slides thumbnails in that section, and apply a different color scheme 

B. Select the slide thumbnails in that section and apply a different design template 

C. Select one of the slide in the section you want to change, customize the fonts and colors, and use 

theformat painter tool to apply those styles to the other slides in the section 

D. All of above 

QUIZ ANSWER ~ : B 

QUIZ ~  104 

The view that displays the slides of a presentation as miniature representations of the slides is called 

A. Slide show 

B. Slide sorter view 

C. Notes page view 

D. Outline view 

QUIZ ANSWER ~ : B 

QUIZ ~  105 

The power point view that displays only text (title and bullets) is: 



A. Slide show 

B. Slide sorter view 

C. Notes page view 

D. Outline view 

QUIZ ANSWER ~ : D 

QUIZ ~  106 

Which of the following provides a printed copy of your presentation? 

A. Outlines 

B. Speaker notes 

C. Audience handouts 

D. All of above 

QUIZ ANSWER ~ : C 

QUIZ ~  107 

Presentation designs regulate the formatting and layout for the slide and are commonly called 

A. Design templates 

B. Templates 

C. Placeholders 

D. Blueprints 

QUIZ ANSWER ~ : B 

QUIZ ~  108 

which of the following should you use if you want all the slides in the presentation to have the same look? 

A. The slid layout option 

B. The add a slide option 

C. Outline view 

D. A presentation design template 

QUIZ ANSWER ~ : D 

QUIZ ~  109 

Line spacing refers to 

A. The space between the lines of text 

B. The height of the line 

C. The length of the line 

D. a and c 

QUIZ ANSWER ~ : A 

QUIZ ~  110 

Which of the following uses the spelling and grammar feature to indicate an incorrect spelling? 

A. The incorrect word appears in all capital letters 

B. The incorrect word has a wavy red line under it 

C. The incorrect word appears italicized 



D. The incorrect word appears bold 

QUIZ ANSWER ~ : B 

QUIZ ~  111 

Which of the following bypasses the print dialog box when printing individual slides or an entire presentation? 

A. File, Print Preview 

B. The print button 

C. File, print 

D. Ctrl + P 

QUIZ ANSWER ~ : B 

QUIZ ~  112 

Which of the following displays when an image is selected? 

A. Add clip art only if it relates to your topic 

B. Be sure to place at least one clipart image per slide 

C. Resize the image so it takes up as much space as your text 

D. A and b 

QUIZ ANSWER ~ : D 

QUIZ ~  113 

The Microsoft clip gallery allows you to 

A. Add word art images to a slide 

B. Spell check your presentation 

C. Add clip art images to a slide or slides 

D. Add slides to a presentation 

QUIZ ANSWER ~ : C 

QUIZ ~  114 

To select all the boxes of an organization chart 

A. Click edit, select all 

B. Right click the chart background click select all 

C. Press and hold the shift key and click each box 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  115 

To adjust the width of table columns, you 

A. Click table menu. Column width, then make adjustments 

B. Drag the vertical gridline between two columns 

C. Drag the column markers on the table ruler bar 

D. b and c 

QUIZ ANSWER ~ : D 



QUIZ ~  116 

To add a new row to a table you would 

A. click the insert rows command on the insert menu 

B. press the enter key 

C. click the insert rows button on the standard toolbar 

D. none of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  117 

After moving a clip art image to a particular location on the slide, you can immediately reverse the action using 

the 

A. Click the not do move object command on the edit menu 

B. Click on the undo button 

C. Click on redo button 

D. All of above 

QUIZ ANSWER ~ : B 

QUIZ ~  118 

Which of the following you must first complete in order to delete an object? 

A. Double click the image 

B. Select the image 

C. Resize the image 

D. Move the image to a new location 

QUIZ ANSWER ~ : B 

QUIZ ~  119 

Which of the following should be used when you want to add a slide to an existing presentation? 

A. File, add a new slide 

B. Insert, new slide 

C. File, open 

D. File, new 

QUIZ ANSWER ~ : B 

QUIZ ~  120 

Which of the following includes special effects that can be applied to drawing objects? 

A. Gradient fills 

B. Line color and style 

C. Rotating 

D. All of above 

QUIZ ANSWER ~ : D 



QUIZ ~  121 

The size of a table object 

A. Is dependent on the amount of text within the table 

B. Is determined by the presentation design but can be changed 

C. Is determined by the presentation design and cannot be changed 

D. a and c 

QUIZ ANSWER ~ : B 

QUIZ ~  122 

Which of the following format options should be used to display dollars on an axis? 

A. Normal 

B. Percentage 

C. Currency 

D. Comma 

QUIZ ANSWER ~ : C 

QUIZ ~  123 

To edit the text within the boxes of an organization chart, you 

A. Select the box and text, then make the changes 

B. Select the box, then make the changes 

C. Highlight the text, then make the changes 

D. Highlight the text then make the change 

QUIZ ANSWER ~ : A 

QUIZ ~  124 

Which of the following options changes the fill color of an object back to the default color? 

A. Template 

B. Automatic 

C. Patterns 

D. Fill colors 

QUIZ ANSWER ~ : B 

QUIZ ~  125 

Which of the following should you use to add shading to a drawing object on or an auto shape object? 

A. Text box tool 

B. Line tool 

C. Fill color 

D. B and c 

QUIZ ANSWER ~ : D 

QUIZ ~  126 

Which of the following tools enable you to add text to a slide without using the standard placeholders? 



A. Text box tool 

B. Line tool; 

C. Fill color 

D. Auto shapes tool 

QUIZ ANSWER ~ : A 

QUIZ ~  127 

A cell is defined as 

A. The intersection of a column and a row 

B. An input box 

C. A rectangular marker 

D. All of the above 

QUIZ ANSWER ~ : A 

QUIZ ~  128 

in order to edit a chart, you can 

A. triple click the chart object 

B. click and drag the chart object 

C. double click the chart object 

D. click the chart objects 

QUIZ ANSWER ~ : C 

QUIZ ~  129 

When an image is selected, it displays which of the following? 

A. Two corner handles 

B. Six middle handles 

C. Eight sizing handles 

D. Six boxes 

QUIZ ANSWER ~ : C 

QUIZ ~  130 

Which of the following features allows you to view slides in a slide show without manually advancing each 

slide? 

A. Adding build effects 

B. Setting slide times 

C. Adding transitions 

D. All of these 

QUIZ ANSWER ~ : B 

QUIZ ~  131 

Animation schemes can be applied to ….. in the presentation 

A. All slides 

B. Select slides 



C. Current slide 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  132 

A file which contains readymade styles that can be used for a presentation is called 

A. Auto style 

B. Template 

C. Wizard 

D. Pre-formatting 

QUIZ ANSWER ~ : B 

QUIZ ~  133 

Which key deletes text before, or the left of, the insertion point? 

A. Backspace 

B. Page up 

C. Delete 

D. Page down 

QUIZ ANSWER ~ : A 

QUIZ ~  134 

To create a PowerPoint presentation from a template 

A. Click File, New, select the presentations tab and choose a template 

B. Click File, New Template and choose a template 

C. Import a presentation template from PowerPoint's template wizard 

D. Click Create Template from scratch, Now 

QUIZ ANSWER ~ : A 

QUIZ ~  135 

to save a presentation you 

A. click save on the windows start button 

B. press Ctrl + F5 

C. select File, Save from the menu 

D. click the saver button on the formatting toolbar 

QUIZ ANSWER ~ : C 

QUIZ ~  136 

To change font size of a selected slide title, you? 

A. Click the toolbars font dropdown arrow and choose the font you prefer 

B. Click format, title and choose a font from the font tab 

C. Click the toolbar's increase font size button 

D. Click title, new font, ok. 



QUIZ ANSWER ~ : C 

QUIZ ~  137 

To change font size of a selected slide title, you: 

A. Click the toolbars Font dropdown arrow and choose the font you prefer 

B. Click Format, Title and choose a font from the font tab 

C. Click the toolbar's Increase Font Size button 

D. Click Title, New Font, OK 

QUIZ ANSWER ~ : C 

QUIZ ~  138 

To insert a new slide in the current presentation, we can choose 

A. Ctrl + M 

B. Ctrl + N 

C. Ctrl + O 

D. Ctrl + F 

QUIZ ANSWER ~ : A 

QUIZ ~  139 

Microsoft PowerPoint is a 

A. Database program 

B. Spreadsheet program 

C. Presentation program 

D. Word processing program 

QUIZ ANSWER ~ : C 

QUIZ ~  140 

Right clicking something in PowerPoint 

A. Deletes the object 

B. Selects the object 

C. Opens a shortcut menu listing for the objectD. Nothing he right mouse button for operation 

QUIZ ANSWER ~ : C 

QUIZ ~  141 

After choosing a predefine template, ….. option has to be chosen to change a background color 

A. Design template 

B. Color scheme 

C. Animation scheme 

D. Color effects 

QUIZ ANSWER ~ : B 

QUIZ ~  142 

We can replace a font on all sides with another font using the …. option 



A. Edit, Fonts 

B. Tools, Fonts 

C. Tools, Replace Fonts 

D. Format, Replace Fonts 

QUIZ ANSWER ~ : D 

QUIZ ~  143 

Special effects used to introduce slides in a presentation are called 

A. Effects 

B. Custom animations 

C. Transitions 

D. Preset animations 

QUIZ ANSWER ~ : C 

QUIZ ~  144 

Which key on the keyboard can be used to view slide show 

A. F1 

B. F2 

C. F5 

D. F10 

QUIZ ANSWER ~ : C 

QUIZ ~  145 

Which of the following fill effects can you use for the slide background? 

A. Gradient 

B. Texture 

C. Picture 

D. All of the above 

QUIZ ANSWER ~ : D 

QUIZ ~  146 

The arrangement of elements such as Title and Subtitle text, pictures, tables is called 

A. Layout 

B. Presentation 

C. Design 

D. Scheme 

QUIZ ANSWER ~ : A 

QUIZ ~  147 

Which view in PowerPoint can be used to enter speaker comments? 

A. Normal 

B. Slide show 

C. Slide sorter 



D. Notes page view 

QUIZ ANSWER ~ : D 

QUIZ ~  148 

The boxes that are displayed to indicate that the text, pictures or objects are placed in it is called …. 

A. Placeholder 

B. Auto text 

C. Text boxD. Word art 

QUIZ ANSWER ~ : A 

QUIZ ~  149 

Which of the following is not a way to cut text? 

A. Select the text and press the delete button 

B. Select the text and select Edit, Cut from the menu 

C. Select the text and click the Cut button on the toolbar 

D. Select the text and press Ctrl + X 

QUIZ ANSWER ~ : A 

QUIZ ~  150 

Which of the following can you use to add times to the slides in a presentation? 

A. Slice Show menu 

B. Rehearse timing button 

C. Slide transition button 

D. All of the above 

QUIZ ANSWER ~ : B 

QUIZ ~  151 

Which of the following is not one of PowerPoint's views? 

A. Slide show view 

B. Slide view 

C. Presentation view 

D. Outline view 

QUIZ ANSWER ~ : C 

QUIZ ~  152 

Which PowerPoint view works best for adding slide transitions? 

A. Slide show view 

B. Slide sorter view 

C. Slide view 

D. Notes view 

QUIZ ANSWER ~ : B 



QUIZ ~  153 

Which of the following views is the best view to use when setting transition effects for all slides in a 

presentation 

A. Slide sorter view 

B. Notes page view 

C. Slide view 

D. Outline view 

QUIZ ANSWER ~ : A 

QUIZ ~  154 

Which option can be used to set custom timings for slides in a presentation? 

A. Slider Timings 

B. Slider Timer 

C. Rehearsal 

D. Slide Show Setup 

QUIZ ANSWER ~ : C 

QUIZ ~  155 

Which of the following will not advance the slides in a slide show view? 

A. The esc key 

B. The space bar 

C. The enter key 

D. The mouse button 

QUIZ ANSWER ~ : A 

QUIZ ~  156 

Format painter 

A. To paint pretty pictures on your slides 

B. To copy formatting from one object or piece of text and then apply it elsewhere 

C. To change the background color of your slides 

D. To paint pretty pictures on background of slides 

QUIZ ANSWER ~ : B 

QUIZ ~  157 

Which tab is not available on left panel when you open a presentation? 

A. Outline 

B. Slides 

C. Notes 

D. All of above are available 

QUIZ ANSWER ~ : C 


